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1 Теоретические сведения 

1.1 Элементы нейронных сетей 
 

Для описания алгоритмов и устройств в нейроинформатике выработана специальная 
"схемотехника", в которой элементарные устройства – сумматоры, синапсы, нейроны и т.п. 
объединяются в сети, предназначенные для решения задач. 

Интересен статус этой схемотехники – для многих начинающих кажется неожиданным, что 
ни в аппаратной реализации нейронных сетей, ни в профессиональном программном обеспечении 
все эти элементы вовсе не обязательно реализуются как отдельные части или блоки. Используемая 
в нейроинформатике идеальная схемотехника представляет собой особый язык для представления 
нейронных сетей и их обуждения. При программной и аппаратной реализации выполненные на 
этом языке описания переводятся на языки другого уровня, более пригодные для реализации. 

Самый заслуженный и, вероятно, наиболее важный элемент нейросистем – это адаптивный 
сумматор. Адаптивный сумматор вычисляет скалярное произведение вектора входного сигнала x 
на вектор параметров α. На схемах будем обозначать его так, как показано на рис. 1. Адаптивным 
называем его из-за наличия вектора настраиваемых параметров α. Для многих задач полезно 
иметь линейную неоднородную функцию выходных сигналов. Ее вычисление также можно 
представить с помощью адаптивного сумматора, имеющего n+1 вход и получающего на 0-й вход 
постоянный единичный сигнал (рис. 2). 
 

 
 
 

 
 

Нелинейный преобразователь сигнала изображен на рис. 3. Он получает скалярный входной 
сигнал x и переводит его в ϕ(x). 

Точка ветвления служит для рассылки одного сигнала по нескольким адресам (рис. 4). Она 
получает скалярный входной сигнал x и передает его всем своим выходам. Стандартный 
формальный нейрон составлен из входного сумматора, нелинейного преобразователя и точки 
ветвления на выходе (рис. 5). 
Линейная связь - синапс - отдельно от сумматоров не встречается, однако для некоторых 
рассуждений бывает удобно выделить этот элемент (рис. 6). Он умножает входной сигнал x на 
«вес синапса» α.  

Также бывает полезно «присоединить» связи не ко входному сумматору, а к 
точке ветвления. В результате получаем элемент, двойственный адаптивному 
сумматору и называемый «выходная звезда». Его выходные связи производят 

умножение сигнала на свои веса. 
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Рис. 1. Адаптивный сумматор. 
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1.2 Архитектура нейронных сетей 
Перейдем теперь к вопросу: как можно составлять эти сети? Строго говоря, как угодно, 

лишь бы входы получали какие-нибудь сигналы. Но такой произвол слишком необозрим, поэтому 
используют несколько стандартных архитектур, из которых путем вырезания лишнего или (реже) 
добавления строят большинство используемых сетей. 

Сначала следует договориться о том, как будет согласована работа различных нейронов во 
времени. Как только в системе возникает более одного элемента, встает вопрос о синхронности 
функционирования. Для привычных нам всем программных имитаторов нейронных сетей на 
цифровых ЭВМ такого вопроса нет только из-за свойств основного компьютера, на котором 
реализуются нейронные сети. Для других способов реализации такой вопрос весьма важен. Все же 
здесь и далее рассматриваются только нейронные сети, синхронно функционирующие в 
дискретные моменты времени: все нейроны срабатывают «разом». 

В зоопарке нейронных сетей можно выделить две базовых архитектуры – слоистые и 
полносвязные сети. 

Слоист
ые сети: 

нейроны 
расположены в 

несколько 
слоев (рис. 7). 

Нейроны 
первого слоя 

получают 
входные 
сигналы, 

преобразуют их 
и через точки 

ветвления передают нейронам второго слоя. Далее срабатывает второй слой и т.д. до k-го слоя, 
который выдает выходные сигналы для интерпретатора и пользователя. Если не оговорено 
противное, то каждый выходной сигнал i-го слоя подается на вход всех нейронов i+1-го. Число 
нейронов в каждом слое может быть любым и никак заранее не связано с количеством нейронов в 
других слоях. Стандартный способ подачи входных сигналов: все нейроны первого слоя получают 
каждый входной сигнал. Особое распространение получили трехслойные сети, в которых каждый 
слой имеет свое наименование: первый – входной, второй – скрытый, третий – выходной.  

Полносвязные сети: каждый нейрон передает свой выходной сигнал остальным нейронам, 
включая самого себя. Выходными сигналами сети могут быть все или некоторые выходные 
сигналы нейронов после нескольких тактов функционирования сети. Все входные сигналы 
подаются всем нейронам. 

Элементы слоистых и полносвязных сетей могут выбираться по-разному. Существует, 
впрочем, стандартный выбор – нейрон с адаптивным неоднородным линейным сумматором на 
входе (рис. 5).  

Для полносвязной сети входной сумматор нейрона фактически распадается на два: первый 
вычисляет линейную функцию от входных сигналов сети, второй – линейную функцию от 
выходных сигналов других нейронов, полученных на предыдущем шаге.  

Функция активации нейронов (характеристическая функция) ϕ – нелинейный 
преобразователь, преобразующий выходной сигнал сумматора (см. рис. 5) – может быть одной и 
той же для всех нейронов сети. В этом случае сеть называют однородной (гомогенной). Если же ϕ 
зависит еще от одного или нескольких параметров, значения которых меняются от нейрона к 
нейрону, то сеть называют неоднородной (гетерогенной). 

Составление сети из нейронов стандартного вида (рис. 5) не является обязательным. 
Слоистая или полносвязная архитектуры не налагают существенных ограничений на участвующие 
в них элементы. Единственное жесткое требование, предъявляемое архитектурой к элементам 

 

.  .  . .  .  . .  .  . 
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Рис. 7. Слоистая сеть 
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сети, это соответствие размерности вектора входных сигналов элемента (она определяется 
архитектурой) числу его входов.  

Если полносвязная сеть функционирует до получения ответа заданное число тактов k, то ее 
можно представить как частный случай k-слойной сети, все слои которой одинаковы и каждый из 
них соответствует такту функционирования полносвязной сети. 

Существенное различие между полносвязной и слоистой сетями возникает тогда, когда 
число тактов функционирования заранее не ограничено – слоистая сеть так работать не может. 

 
1.3 Существуют ли функции многих переменных ? 

Вопрос, вынесенный в заголовок раздела, естественно возникает при изучении 
возможностей нейронных сетей. Из схем предыдущих разделов видно, что нейронные сети 
вычисляют линейные функции, нелинейные функции одного переменного, а также всевозможные 
суперпозиции - функции от функций, получаемые при каскадном соединении сетей. Что можно 
получить, используя только такие операции? Какие функции удастся вычислить точно, а какие 
функции можно сколь угодно точно аппроксимировать с помощью нейронных сетей? Чтобы 
изучить возможности нейронных сетей, нужно ответить на эти вопросы. 
Заданный вопрос имеет очень большую историю и заведомо старше, чем исследования 
искусственных нейронных сетей. 
Какие функции может вычислять человек? Если мы умеем складывать и умножать числа, то мы 
можем точно вычислять многочлены и рациональные функции (отношения многочленов) с 
рациональными коэффициентами от рациональных же аргументов.  
Можно, однако, задавать функции с помощью уравнений. Если считать решения нескольких 
простых уравнений известными, то класс вычисляемых функций расширится - решения некоторых 
более общих уравнений удастся выразить через эти, более простые функции.  

Классический пример: если использовать радикалы - решения уравнений xn=a, то можно 
явно получить решения произвольных уравнений 2-й, 3-й и 4-й степеней. Так, функция 3-х 
переменных a, b, c - решение уравнения ax2+bx+c=0 - может быть точно выражена с помощью 
сложения, умножения, деления и функции одного переменного - квадратного корня. 

Вопрос: можно ли представить решение любого алгебраического уравнения с помощью 
радикалов, был окончательно и отрицательно решен Абелем и Галуа - уже уравнения 5-й степени 
неразрешимы в радикалах.  

Все же можно подбирать другие простые функции небольшого числа переменных - 
сложнее, чем радикалы, но проще, чем общие решения уравнений высоких степеней. Удастся ли с 
помощью этих функций построить решение любого уравнения? Вопрос был настолько важен, что 
Гильберт в списке своих проблем, которые, по его мнению, должны были определять развитие 
математики XX века, под номером 13 поместил следующую задачу: 

Представляется ли корень уравнения 
x7+ax3+bx2+cx+1=0 
(как функция коэффициентов) суперпозицией каких-либо непрерывных функций двух 

переменных? 
Для уравнений 5-й и 6-й степени такое представление возможно не только с помощью 

непрерывных, но даже аналитических функций. 
Оказалось полезным абстрагироваться от уравнений и поставить общий вопрос: можно ли 

произвольную непрерывную функцию n переменных получить с помощью операций сложения, 
умножения и суперпозиции из непрерывных функций двух переменных? Ответ оказался 
положительным! В серии работ [1-3] А.Н.Колмогоров, затем В.И.Арнольд и вновь 
А.Н.Колмогоров решили эту проблему: можно получить любую непрерывную функцию n 
переменных с помощью операций сложения, умножения и суперпозиции из непрерывных 
функций одного переменного. 

Последняя теорема А.Н.Колмогорова [3] из этой серии настолько проста и изящна, что мы 
чуть позже приведем ее целиком. А пока - несколько замечаний о условиях теоремы. 
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От условия непрерывности можно отказаться - тогда получится довольно тривиальный 
результат связанный, по существу, с равномощностью отрезка и куба любой размерности. Условие 
непрерывности нельзя значительно усилить: существуют аналитические функции многих 
переменных, которые не допускают представления с помощью суперпозиции аналитических 
функций двух переменных. Более того, все l раз непрерывно дифференцируемые функции трех 
переменных нельзя представить в виде суперпозиций функций двух переменных, каждая из 
которых дифференцируема [2l/3] раз и все частные производные которых порядка [2l/3] 
удовлетворяют условию Липшица (выражение [2l/3] означает целую часть числа 2l/3). Это 
доказано А.Г,Витушкиным [4]. 

А теперь - теорема Колмогорова, завершившая серию исследований для непрерывных 
функций: 

Каждая непрерывная функция n переменных, заданная на единичном кубе n-мерного 
пространства, представима в виде 

f x x x h xn q
q

n

q
p

p
p

n
( , , ..., ) ( ) ,1 2

1

2 1

1
=

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥=

+

=
∑ ∑ϕ         (1) 

где функции h uq ( )  непрерывны, а функции ϕq
p

px( ) , кроме того, еще и стандартны, т.е. не 
зависят от выбора функции f.  

В частности, каждая непрерывная функция двух переменных x, y представима в виде  

[ ]f x y h x yq q q
q

( , ) ( ) ( ) .= +
=
∑ ϕ ψ

1

5
         (2) 

Доказательство настолько просто, изящно и поучительно, что мы приведем его практически 
полностью для случая n=2, следуя изложению В.И.Арнольда [5]. Возможность представления (2) 
доказывается в несколько этапов. 

1. "Внутренние" функции ϕq x( )  и ψ q y( )  представления (2) совершенно не зависят от 

разлагаемой функции f x y( , ) . 
Для определения этих функций нам понадобятся некоторые предварительные построения. 

Рассмотрим изображенный на рис. 8 "город" –систему одинаковых "кварталов" 
(непересекающихся замкнутых квадратов), разделенных узкими "улицами" одной и той же 
ширины. Уменьшим гомотетично наш "город" в N  раз; за центр гомотетии можно принять, 
например, точку A1 – мы получим новый" город", который будем называть "городом ранга 2". 
"Город ранга 3" точно также получается из "города ранга 2" гомотетичным уменьшением с 

коэффициентом гомотетии 
1
N

; "город ранга 4" получается гомотетичным уменьшением в N  раз 

"города ранга 3" и т.д. Вообще "город ранга k " получается из исходного "города" (который мы 

будем называть "городом первого ранга") гомотетичным уменьшением в N k  раз (с центром 
гомотетии в A1; впрочем, выбор центра гомотетии не существенен для дальнейшего). 
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Построенную систему "городов" мы 
назовем 1-й системой. "Город первого ранга q -й 
системы" (q = 2 5,... , ) получается из 
изображенного на рис. 8 "города" при помощи 
параллельного переноса, совмещающего точку 
A1 с точкой Aq . Нетрудно понять, что "улицы" 
"города" можно выбрать настолько узкими, что 
каждая точка плоскости будет покрыта по 
крайней мере тремя кварталами наших пяти 
"городов первого ранга". Точно так же "город k -
го ранга" q -й системы ( k q= =2 3 2 5, ,...; ,... , ) 
получается из "города k -го ранга 1-й системы" 
параллельным переносом, переводящим точку 

Ak
1  в точку Aq

k , где Ak
1  и Aq

k  получаются из 

точек A1 и Aq  гомотетией, переводящей "город первого ранга" 1-й системы (т.е. наш исходный 

"город") в "город k -го ранга" той же системы; при этом каждая точка плоскости будет 
принадлежать кварталам по крайней мере трех из пяти "городов" любого фиксированного ранга 
k . 

Функцию  
Φq q qx y x y( , ) ( ) ( )= +ϕ ψ  ( q = 1 2 5, ,..., ) 
мы определим теперь так, чтобы она разделяла любые два "квартала" каждого "города" 

системы q , т.е. чтобы множество значений, принимаемых Φq x y( , )  на определенном "квартале" 

"города k -го ранга" (здесь k – произвольное фиксированное число) q -й системы, не 
пересекалось с множеством значений, принимаемых Φq x y( , )  на любом другом "квартале" того 
же "города". При этом нам, разумеется, будет достаточно рассматривать функцию Φq x y( , )  на 
единичном квадрате (а не на всей плоскости). 

Для того, чтобы функция Φq q qx y x y( , ) ( ) ( )= +ϕ ψ  разделяла "кварталы" "города 

первого ранга", можно потребовать, например, чтобы ϕq x( )  на проекциях "кварталов" "города" 
на ось x  весьма мало отличалась от различных целых чисел, а ψ q y( )  на проекциях “кварталов” на 

ось y  весьма мало отличалась от различных кратных 2  (ибо m n m n+ = +2 2' '  при целых 
m n m n, , ' , ' , лишь если m m n n= =' , ' ). При этом наложенные условия не определяют пока еще, 
разумеется, функций ϕq x( )  и ψq y( )  (на "улицах" функция Φq q qx y x y( , ) ( ) ( )= +ϕ ψ  вообще пока 
может задаваться совершенно произвольно); используя это, можно подобрать границы значений 
ϕq x( )  и ψ q y( )  на "кварталах" "города второго ранга" так, чтобы функция 
Φq q qx y x y( , ) ( ) ( )= +ϕ ψ  разделяла не только "кварталы" "города 1-го ранга", но и “кварталы” 
"города 2-го ранга". Намеченную программу можно осуществить, если N  достаточно велико (так 
что кварталы последующих рангов не соединяют кварталы предыдущих). А.Н. Колмогоров 
выбрал N = 18. Привлекая подобным же образом к рассмотрению "города" последующих рангов 
и уточняя каждый раз значения функций ϕq x( )  и ψ q y( ) , мы в пределе получим непрерывные 
функции ϕq x( )  и ψ q y( )  (можно даже потребовать, чтобы они были монотонными), 
удовлетворяющие поставленным условиям. 

2. Функции h uq( )  разложения (2), напротив того, существенно зависят от исходной 

функции f x y( , ) . 

 
 

A1 

A5 

A2 
A3 

A4 

Ðèñ. 8. Система кварталов. 
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Для построения этих функций докажем прежде всего, что любую непрерывную функцию 
f x y( , )  двух переменных x  и y , заданную на единичном квадрате, можно представить в виде  

f x y h x y f x yq q
q

( , ) ( ( , )) ( , )( )= +
=
∑ 1

1

5

1Φ    (3) 

где Φq q qx y x y( , ) ( ) ( )= +ϕ ψ  – функции, построенные выше, и  

M f x y f x y M1 1
5
6

5
6

= ≤ =max ( , ) max ( , ) ,    (3а) 

 max ( ( , ))( )h x y Mq q
1 1

3
Φ ≤ , q =1 5,... , .    (3б) 

Выберем ранг k  столь большим, чтобы колебание (т.е. разность наибольшего и 
наименьшего значений) функции f x y( , )  на каждом "квартале" любого из "городов ранга k " не 

превосходило 
1
6

M ; это, разумеется, возможно, так как с ростом ранга k  размеры " кварталов" 

уменьшаются неограниченно. Далее, пусть p ij
1
( )  – определенный "квартал" "города 1-й системы" 

(и выбранного ранга k ); в таком случае (непрерывная) функция Φ1( , )x y  принимает на этом 

"квартале" значения, принадлежащие определенному сегменту Δ1
( )ij  числовой оси (причем в силу 

определения функции Φ1 этот сегмент не пересекается с сегментами значений, принимаемых Φ1 

на всех других "кварталах"). Положим теперь функцию h1
1( )  на сегменте Δ1

( )ij  постоянной, 

равной 
1
3

 значения, принимаемого функцией f x y( , )  в какой-либо (безразлично какой) 

внутренней точке M ij
1
( )  квартала p ij

1
( )  (эту точку можно назвать "центром квартала"). Таким же 

образом мы определим функцию h1
1( )  на любом другом из сегментов, задаваемых значениями 

функции Φ1( , )x y  на "кварталах" "города k -го ранга" 1-й системы; при этом все значения h1
1( )  

будут по модулю не превосходить 
1
3

M  (ибо значение f x y( , )  в "центре" любого "квартала" по 

модулю не превосходит M ). Доопределим теперь функцию h u1
1( )( )  при тех значениях 

аргумента u , при каких она еще не определена, произвольно, с тем лишь, чтобы она была 
непрерывна и чтобы выполнялось неравенство (3б); совершенно аналогично определим и все 

остальные функции h uq
( )( )1  (q = 2 5,... , ). 

Докажем теперь, что разность  

 f x y f x y h x yq q
q

1
1

1

5
( , ) ( , ) ( ( , ))( )= −

=
∑ Φ  

удовлетворяет условию (3а), т.е. что  

 f x y M1 0 0
5
6

( , ) ≤ , 

где ( , )x y0 0  – произвольная точка единичного квадрата. Эта точка (как и все точки плоскости) 
принадлежит по крайней мере трем кварталам "городов ранга k "; поэтому заведомо найдутся 

такие три из пяти функций h x yq1
1( )( ( , ) )Φ , которые принимают в точке ( , )x y0 0  значение, 
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равное 
1
3

 значения f x y( , )  в "центре" соответствующего "квартала", т.е. отличающееся от 

1
3 0 0f x y( , )  не более чем на 

1
18

M  (ибо колебание f x y( , )  на каждом квартале не превосходит 

1
6

M ); сумма этих трех значений h x yq q
( )( ( , ))1

0 0Φ  будет отличаться от f x y( , )0 0  по модулю не 

более чем на 
1
6

M . А так как каждое из оставшихся двух чисел h x yq q
( )( ( , ))1

0 0Φ  в силу (3) по 

модулю не превосходит 
1
3

M  то мы получаем: 

f x y f x y h x y M M Mq q
q

1 0 0 0 0
1

0 0
1

5 1
6

2
3

5
6

( , ) ( , ) ( ( , ))( )= − ≤ + =
=
∑ Φ , 

что и доказывает (3а). 
 Применим теперь то же разложение (3) к входящей в (3) функции f x y1( , ) ; мы получим: 

 f x y h x y f x yq q
q

1
2

2
1

5
( , ) ( ( , )) ( , )( )= +

=
∑ Φ  

или 

f x y h x y h x y f x yq q
q

q q
q

( , ) ( ( , )) ( ( , )) ( , )( ) ( )= + +
= =
∑ ∑1

1

5
2

1

5

2Φ Φ , 

где 

M f x y M M2 2 1

25
6

5
6

= ≤ = ⎛⎝⎜
⎞
⎠⎟max ( , )   

и max ( ( , ))( )h x y M Mq q
2

1
1
3

1
3

5
6

Φ ≤ ≤ ⋅  (q =12 5, ,... , ). 

Затем мы применим разложение (3) к полученной функции f x y2( , )  и т.д.; после n -
кратного применения этого разложения мы будем иметь: 

f x y h x y h x y f x yq q
q

q q
q

( , ) ( ( , )) ( ( , )) ( , ) ...( ) ( )= + + +
= =
∑ ∑1

1

5
2

1

5

2Φ Φ   

... ( ( , )) ( , )( )+ +−

=
∑ h x y f x yq

n
q

q
n

1

1

5
Φ , 

 где 

 M f x y Mn n

n
= ≤ ⎛⎝⎜

⎞
⎠⎟max ( , )

5
6

 

и 

 max ( ( , ))( )h x y Mq
s

q

s
Φ ≤ ⋅ ⎛⎝⎜

⎞
⎠⎟
−1

3
5
6

1
 (q s n= = −12 5 12 1, ,... , ; , ,... , ). 

Последние оценки показывают, что при n→∞  получим: 

f x y h x y h x y f x yq q
q

q q
q

( , ) ( ( , )) ( ( , )) ( , ) ...( ) ( )= + + +
= =
∑ ∑1

1

5
2

1

5

2Φ Φ  
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... ( ( , )) ...( )+ +
=
∑ h x yq

n
q

q
Φ

1

5
 

где стоящий справа бесконечный ряд сходится равномерно; также и каждый из пяти рядов 
 h x y h x y h x yq q q q q

n
q

( ) ( ) ( )( ( , )) ( ( , )) ( ( , )) ...1 2Φ Φ Φ+ + +  (q =12 5, ,... , )  
сходится равномерно, что позволяет ввести обозначения 

 h u h h hq q q q
n( ) ... ...( ) ( ) ( )= + + + +1 2  (q =12 5, ,... , ). 

Итак, окончательно получаем: 

[ ]f x y h x y h x yq q
q q

q q q( , ) ( ( , )) ( ) ( )= = +
= =
∑ ∑Φ

1

5

1

5
ϕ ψ  , 

то есть требуемое разложение (2). 
До сих пор речь шла о точном представлении функций многих переменных с помощью 

функций одного переменного. Оказалось, что в классе непрерывных функций такое представление 
возможно. Но кроме вопроса о точном представлении существует еще один - об аппроксимации. 
Можно даже предположить, что он важнее - вычисление большинства функций производится 
приближенно даже при наличии «точных» формул. 

Приближение функций многочленами и рациональными функциями имеет историю, еще 
более давнюю, чем проблема точного представления. Знаменитая теорема Вейерштрасса 
утверждает, что непрерывную функцию нескольких переменных f x x xn( , ,..., )1 2  на замкнутом 
ограниченном множестве Q можно равномерно приблизить последовательностью полиномов: для 
любого ε>0 существует такой многочлен P x x xn( , , ..., )1 2 , что  

sup
Q

| ( , ,..., ) ( , ,..., )|f x x x P x x xn n1 2 1 2− < ε . 

Чтобы сформулировать обобщения и усиления теоремы Вейерштрасса, необходимо 
перейти к несколько более абстрактному языку. Рассмотрим компактное пространство X и алгебру 
C(X) непрерывных функций на X с вещественными значениями. 

Сильным обобщением теоремы о возможности равномерного приближения непрерывных 
функций многочленами является теорема Стоуна [6,7]: 

Пусть E⊆C(X) - замкнутая подалгебра в C(X), 1∈E и функции из E разделяют точки в X 
(то есть для любых различных x,y∈X существует такая функция g∈E, что g(x)≠g(y)). Тогда 
E=C(X). 

Теорема Стоуна обобщает теорему Вейерштрасса по двум направлениям. Во-первых, 
рассматриваются функции на произвольном компакте, а не только функции многих 
действительных переменных. Во-вторых, доказано утверждение, новое даже для функций одного 
переменного (не говоря уже о многих): плотно не только множество многочленов от 
координатных функций, но вообще кольцо многочленов от любого набора функций, разделяющих 
точки. Следовательно, плотно множество тригонометрических многочленов, множество линейных 
комбинаций функций вида exp[-(x-x0,Q(x-x0))], где (x,Qx) - положительно определенная 
квадратичная форма и др. 

Дан рецепт конструирования таких обобщений: достаточно взять произвольный набор 
функций, разделяющих точки, построить кольцо многочленов от них - и получим плотное в C(X) 
множество функций. 

Разложения по ортогональным системам функций (ряды Фурье и их многочисленные 
обобщения) не дают, вообще говоря, равномерного приближения разлагаемых функций - как 
правило, можно гарантировать лишь монотонное стремление к нулю интеграла квадрата остатка 
«функция минус приближение» с какой-либо положительной весовой функцией. Все же, 
обращаясь к задаче аппроксимации, нельзя забывать об ортогональных разложениях. Для ряда 
прикладных задач простота получения коэффициентов такого разложения может оказаться 
важнее, чем отсутствие гарантированной равномерности приближения. 
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Так существуют ли функции многих переменных? В каком-то смысле - да, в каком-то - нет. 
Все непрерывные функции многих переменных могут быть получены из непрерывных функций 
одного переменного с помощью линейных операций и суперпозиции. Требования гладкости и 
аналитичности существенно усложняют вопрос. На этом фоне совершенно неожиданно выглядит 
тот факт, что любой многочлен от многих переменных может быть получен из одного 
произвольного нелинейного многочлена от одного переменного с помощью линейных операций и 
суперпозиции. Простое доказательство этой теоремы будет дано в разделе 6. 

 
1.4 Универсальные аппроксимационные способности произвольной нелинейности и 

обобщенная теорема Стоуна 
В этом разделе для множеств непрерывных функций, замкнутых относительно любой 

нелинейной операции (а не только для колец), доказана обобщенная аппроксимационная теорема 
Стоуна. Это интерпретируется как утверждение о универсальных аппроксимационных 
возможностях произвольной нелинейности: с помощью линейных операций и каскадного 
соединения можно из произвольного нелинейного элемента получить устройство, вычисляющее 
любую непрерывную функцию с любой наперед заданной точностью. 

Рассмотрим компактное пространство X и алгебру C(X) непрерывных функций на X с 
вещественными значениями. 

Кроме аппроксимации функций многочленами и их обобщениями из колец функций, 
разделяющих точки, в последнее время все большее внимание уделяется приближению функций 
многих переменных с помощью линейных операций и суперпозиций функций одного 
переменного. Такое приближение осуществляется специальными формальными "устройствами" – 
нейронными сетями. Каждая сеть состоит из формальных нейронов. Нейрон получает на входе 
вектор сигналов x, вычисляет его скалярное произведение на вектор весов α и некоторую 
функцию одного переменного ϕ(x,α). Результат рассылается на входы других нейронов или 
передается на выход. Таким образом, нейронные сети вычисляют суперпозиции простых функций 
одного переменного и их линейных комбинаций. 

Доказан ряд теорем [8-10] об аппроксимации непрерывных функций многих переменных 
нейронными сетями с использованием практически произвольной непрерывной функции одного 
переменного. В данном разделе мы покажем, что эта функция действительно может быть 
произвольной и докажем обобщенную теорему Стоуна, естественным образом охватывающую и 
классическую теорему Стоуна, и аппроксимацию функций многих переменных суперпозициями и 
линейными комбинациями функций одного переменного. 

Чтобы получить требуемое обобщение, перейдем от рассмотрения колец функций к 
изучению их алгебр, замкнутых относительно некоторой нелинейной унарной операции.  

Пусть E⊆C(X) - линейное пространство, C(R) - пространство непрерывных функций на 
действительной оси R, f∈С(R) - нелинейная функция и для любого g∈E выполнено f(g)∈E. В этом 
случае будем говорить, что E замкнуто относительно нелинейной унарной операции f. 

Очевидный пример: множество функций n переменных, которые можно точно представить, 
используя заданную функцию одного переменного и линейные функции, является линейным 
пространством, замкнутым относительно нелинейной унарной операции f. 

Замечание. Линейное пространство E⊆C(X) замкнуто относительно нелинейной операции 
f(x)=x2 тогда и только тогда, когда E является кольцом. 

Действительно, [ ]fg f g f g= + − −
1
2

2 2 2( )  поэтому для линейного пространства E⊆C(X) 

замкнутость относительно унарной операции f(x)=x2 равносильна замкнутости относительно 
произведения функций. 

Согласно приведенному замечанию, теорема Стоуна может быть переформулирована так.  
Пусть E⊆C(X) - замкнутое линейное подпространство в C(X), 1∈E, функции из E разделяют 

точки в X и E замкнуто относительно нелинейной унарной операции f(x)=x2. Тогда E=C(X). 
Наше обобщение теоремы Стоуна состоит в замене f(x)=x2 на произвольную нелинейную 

непрерывную функцию.  
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Теорема 1. Пусть E⊆C(X) - замкнутое линейное подпространство в C(X), 1∈E, функции из E 
разделяют точки в X и E замкнуто относительно нелинейной унарной операции f∈C(R). Тогда 
E=C(X). 

Доказательство. Рассмотрим множество всех таких p∈C(R), что p(E)⊆E, то есть для любого 
g∈E выполнено: p(g)∈E. Обозначим это множество PE. Оно обладает следующими свойствами: 

1) PE - полугруппа относительно суперпозиции функций; 
2) PE - замкнутое линейное подпространство в C(R) (в топологии равномерной сходимости 

на компактах); 
3) 1∈PE и id∈PE (id(x)≡x). 
4) PE включает хоть одну непрерывную нелинейную функцию. 
Дальнейшее следует из теоремы 2, которая является, по существу, подготовительной 

теоремой о полугруппах функций. 
Теорема 2. Пусть множество P⊆C(R) удовлетворяет условиям 1-4. Тогда P=C(R). 
Доказательство опирается на три леммы.  
Лемма 1. В условиях теоремы 2 существует дважды непрерывно дифференцируемая 

функция g∈P, не являющаяся линейной. 
Доказательство. Пусть v(x)∈C∞(R), v(x)=0 при |x| >1, ∫Rv(x)dx=1. Ðàññìîòðèì îïåðàòîð 

îñðåäíåíèÿ 

J f x f x y v
y

dy
R

ε ε ε
( ) ( )= + ⎛

⎝⎜
⎞
⎠⎟∫

1
 

Для любого ε>0 выполнено: J f x Pε ( ) ∈ . 
 Действительно, f(x+y)∈E для каждого фиксированного y (т.к. константы принадлежат E и E 

замкнуто относительно линейных операций и суперпозиции функций). Интеграл J f xε ( ) . 
принадлежит E, так как E является замкнутым линейным подпространством в C(R), а этот 
интеграл - пределом конечных сумм. 

Функция J f xε ( ) принадлежит C∞(R) так как  

J f x f x y v
y

dy f z v
z x

dz
R R

ε ε ε ε ε
( ) ( ) ( )= + ⎛

⎝⎜
⎞
⎠⎟ =

−⎛
⎝⎜

⎞
⎠⎟∫ ∫

1 1
 

(напомним, что v – функция с компактным носителем). 
Существует такое ε>0, что функция g= J fε  не является линейной, поскольку J f fε →  при 

ε →0, пространство линейных функций замкнуто, а f не является линейной функцией. Таким 
образом, в предположениях леммы существует нелинейная функция g∈P∩C∞(R), которую можно 
выбрать в виде g= J fε  

Лемма 2. Пусть в условиях теоремы 2 существует дважды непрерывно дифференцируемая 
функция g∈P, не являющаяся линейной. Тогда функция q(x)=x2 принадлежит P. 

Доказательство. Существует точка x0, для которой g′′(x0)≠0. Обозначим 
r(x)=2(g(x+x0)-g(x0)-xg′(x0))/g′′(x0). Очевидно, что r∈P, r(0)=0, r′(0)=0, r′′(0)=2, r(x)=x2+o(x2). 
Поэтому  

r(ε x)/ε2 → x2 при ε → 0. 
Поскольку P замкнуто, получаем: функция q(x)=x2 принадлежит P. 
Лемма 3. Пусть в условиях теоремы 2 функция q(x)=x2 принадлежит P. Тогда P является 

кольцом – для любых f,g∈P их произведение fg∈P. 

Доказательство. Действительно, [ ]fg f g f g= + − −
1
2

2 2 2( ) и, так как P замкнуто 

относительно суперпозиции и линейных операций, то fg∈P. 
Доказательство теоремы 2 заканчивается обращением к классической теореме 

Вейерштрасса о приближении функций многочленами: из лемм 1-3 следует, что в условиях 
теоремы 2 P является кольцом и, в частности, содержит все многочлены (которые получаются из 1 
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и id с помощью умножения и линейных операций). По теореме Вейерштрасса отсюда следует, что 
P=C(R). 

Теоремы 1,2 можно трактовать как утверждения о универсальных аппроксимационных 
свойствах любой нелинейности: с помощью линейных операций и каскадного соединения можно 
из произвольных нелинейных элементов получить любой требуемый результат с любой наперед 
заданной точностью. 

 
1.5 Точное представление многочленов от многих переменных с помощью одного 

произвольного многочлена от одного переменного, линейных операций и суперпозиции 
В этом разделе исследуются полугруппы полиномов от одного переменного относительно 

суперпозиции. Показано, что если такая полугруппа содержит все многочлены первой степени и 
хотя бы один – более высокой, то она включает все многочлены. На основании этого факта 
доказано, что всегда возможно представить многочлен от многих переменных суперпозициями 
произвольного нелинейного многочлена от одного переменного и линейных функций. 

Вернемся к классическому вопросу о представлении функций многих переменных с 
помощью функций меньшего числа переменных. Следует еще раз заметить, что классических 
вопроса существует не один, а два: 

1. Можно ли получить точное представление функции многих переменных с помощью 
суперпозиции функций меньшего числа переменных? 

2. Можно ли получить сколь угодно точную аппроксимацию функции многих переменных с 
помощью некоторых более простых функций и операций? 

В рамках первого вопроса особый интерес представляют конструкции, в которых для 
точного представления всех функций многих переменных используется один и тот же набор 
функций одного переменного. 

Традиционно считается, что эти функции должны иметь весьма специальный и довольно 
экзотический вид, например, как в обсуждавшейся выше теореме Колмогорова, где 
использовались существенно негладкие функции. 

Напротив, свобода в выборе функций одного переменного для решения второго вопроса 
при том же самоограничении ( один набор функций одного переменного - для приближенного 
представления всех функций многих переменных) очень велика. Для этого, как показано в 
предыдущем разделе, можно использовать практически любую нелинейную функцию и 
достаточно всего одной.  

Далее доказываются теоремы, относящиеся к первому вопросу (точное представление). В 
частности, показано, что можно точно представить любой многочлен от многих переменных с 
помощью суперпозиций произвольного нелинейного многочлена от одного переменного и 
линейных функций. Следовательно особенной пропасти между 1-м и 2-м вопросом не существует. 
Именно это обстоятельство побудило нас включить в книгу данный раздел. 

Пусть R[X] - кольцо многочленов от одного переменного над полем R, E⊂R[X] - линейное 
пространство многочленов над R. 

Предложение 1. Если E замкнуто относительно суперпозиции многочленов, содержит все 
многочлены первой степени и хотя бы один многочлен p(x) степени m>1, то E=R[X]. 

Доказательство. Заметим, что степень многочлена p′(x)=p(x+1)-p(x) равна m-1, и p′(x)∈E, 
так как E содержит многочлены первой степени (поэтому x+1∈E), замкнуто относительно 
суперпозиции (поэтому p(x+1)∈E) и линейных операций (поэтому p′(x)∈E). 

Если m>2, то понижаем степень с помощью конечных разностей (переходим к p′, p′′ и т.д.), 
пока не получим многочлен второй степени. Вычитая из него линейную часть и умножая на 
константу, получаем: x2∈E. Поэтому для любого f∈E имеем f2∈E (т.к. E - полугруппа). 
Дальнейшее очевидно: как неоднократно отмечалось выше, отсюда следует, что для любых f,g∈E 
их произведение fg∈E а с помощью умножения и сложения многочленов первой степени 
порождается все кольцо R[X]. 

Перейдем к задаче представления многочленов от многих переменных. Обозначим R[X1, ..., 
Xn] кольцо многочленов от n переменных над полем R. 
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Для каждого многочлена от одного переменного введем множество тех многочленов, которые 
можно выразить с его помощью, используя суперпозиции и линейные функции. Пусть p – многочлен от 
одного переменного, Ep[X1, ..., Xn] – множество многочленов от n переменных, которое можно получить из p 
и многочленов первой степени, принадлежащих R[X1, ..., Xn], с помощью операций суперпозиции, сложения 
и умножения на число. 

Следующие два предложения дают удобную для дальнейшего характеризацию Ep[X1, ..., Xn] и 
следуют непосредственно из определений. 

Предложение 2. Множество Ep[X1, ..., Xn] является линейным пространством над R и для любого 
многочлена g(x1, ... ,xn) из Ep[X1, ..., Xn] p(g(x1, ... ,xn))∈Ep[X1, ..., Xn]. 

Предложение 3.Для данного p семейство линейных подпространств L⊆R[X1, ..., Xn], содержащих все 
многочлены первой степени и удовлетворяющих условию 

если g(x1, ... ,xn)∈L, то p(g(x1, ... ,xn))∈L, 
замкнуто относительно пересечений. Минимальным по включению элементом этого семейства 

является Ep[X1, ..., Xn]. 
Для любого линейного подпространства E⊆R[X1, ..., Xn] рассмотрим множество алгебраических 

унарных операций, которые переводят элементы E в элементы E: 
PE={p∈R[X] | p(g(x1, ... ,xn))∈E для любого g(x1, ... ,xn)∈E}. 
Предложение 4. Для любого линейного подпространства E⊆R[X1, ... ,Xn] множество полиномов PE 

является линейным пространством над R, замкнуто относительно суперпозиции и содержит все 
однородные многочлены первой степени. 

Если линейное пространство E содержит 1, а PE включает хотя бы один многочлен, степени m>1 
(т.е. нелинейный), то PE=R[X]. 

Доказательство. Замкнутость PE относительно суперпозиции следует из определения, все 
однородные полиномы первой степени входят в PE, поскольку E является линейным пространством, отсюда 
также следует, что PE является линейным пространством. Наконец, если 1∈E и PE содержит многочлен 
степени m>1, то 1∈PE, тогда PE=R[X] по предложению 1. 

Теорема 3. Пусть E⊆R[X1, ..., Xn] – линейное подпространство, PE содержит хотя бы один многочлен 
степени m>1 и 1∈E, тогда E является кольцом (с единицей). 

Доказательство. По предложению 4 в условиях теоремы PE=R[X]. В частности, x2∈PE. Это означает, 
что для любого f∈E также и f2∈E. Поэтому для любых f,g∈E получаем: fg∈E. 

Теорема 4. Для любого многочлена p степени m>1  
Ep[X1, ..., Xn]=R[X1, ..., Xn] 
Доказательство. Заметим, что E=Ep[X1, ..., Xn] – линейное подпространство в R[X1, ..., Xn], PE 

содержит хотя бы один многочлен (p) степени m>1 и E содержит все многочлены первой степени (и 
поэтому также 1). В силу теоремы 3, E является кольцом, а так как оно содержит все многочлены первой 
степени, то совпадает с R[X1, ..., Xn], поскольку, используя умножение и сложение можно из этих 
многочленов получить любой. 

Таким образом, из p и многочленов первой степени с помощью операций суперпозиции, сложения и 
умножения на число можно получить все элементы R[X1, ..., Xn]. 

 
1.6 Нейронные сети – универсальные аппроксимирующие 

Класс функций, вычислимый с помощью нейронных сетей, замкнут относительно линейных 
операций. Действительно, пусть есть нейронные сети S1, S2, ..., Sk , которые вычисляют функции F1, F2, ..., Fk 
от вектора входных сигналов x. Линейная комбинация α0+α1F1+α2F2+...+αkFk вычисляется сумматором (рис. 
2) с весами α0, α1, α2, ...,αk, на вход которого подаются выходные сигналы сетей S1, S2, ..., Sk. Разница в 
числе тактов функционирования этих сетей до получения ответа легко компенсируется «линиями 
задержки», составленными из связей (рис. 6) с единичным весом. 

Кроме того, класс функций, вычислимый с помощью нейронных сетей, замкнут относительно 
унарной операции, осуществляемой нелинейным преобразователем сигнала, входящим в состав нейрона 
(см. рис. 3, 5): если сеть S вычисляет функцию F, то, подавая выход этой сети на вход нелинейного 
преобразователя (рис. 3), получим на его выходе функцию ϕ(F). 

Тем самым, по теореме 1 множество функций, вычислимых нейронными сетями с заданной 
непрерывной нелинейной характеристической функцией, плотно в пространстве непрерывных функций от 
входных сигналов. 
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Теперь - об имитации гладких автоматов с помощью нейронных сетей. Если есть возможность с 
любой точностью приблизить любую непрерывную функцию и нет ограничений на способы соединения 
устройств, то можно сколь угодно точно имитировать работу любого непрерывного автомата. Покажем это.  

Каждый автомат имеет несколько входов (n), несколько выходов (p) и конечный набор (s) 
параметров состояния. Он вычисляет s+p функций от n+s переменных. Аргументы этих функций - входные 
сигналы (их n) и текущие параметры состояния (их s). Значения функций – выходные сигналы (их p) и 
параметры состояния на следующем шаге (их s). Каждый такой автомат можно представить как систему из 
s+p более простых автоматов (рис. 9). Эти простые автоматы вычисляют по одной функции от n+s 
переменных. Смена состояний достигается за счет того, что часть значений этих функций на следующем 
шаге становится аргументами – так соединены автоматы (см. рис. 9). 

Таким образом, без потери общности можно рассматривать сеть автоматов как набор устройств, 
каждое из которых вычисляет функцию нескольких переменных f(x1, ... ,xn). Этот простой, но 
фундаментальный факт позволяет использовать предыдущие результаты. Нейронные сети позволяют с 
любой точностью вычислять произвольную непрерывную функцию f(x1, ... ,xn). Следовательно, с их 
помощью можно сколь угодно точно аппроксимировать функционирование любого непрерывного 
автомата. 
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Рис. 9. Представление общего автомата с помощью модулей, 

вычисляющих функции многих переменных от входных сигналов: на верхней 
схеме представлено функционирование автомата, на нижней он разложен на 
отдельные модули. Приняты обозначения: 

In - входные сигналы, Out - выходные сигналы, S - параметры состояния,  
T - дискретное время, Out(In,S) - зависимость выходных сигналов от значений 
входных и параметров состояния, S′(In,S) - зависимость состояния в следующий 
момент дискретного времени от входных сигналов и текущего состояния, f1-fp - 
функции переменных (In,S) - компоненты вектора Out(In,S), fp+1-fp+s - функции 
переменных (In,S) - компоненты вектора S′(In,S), индексами T, T±1 обозначены 
соответствующие моменты времени. 
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2 Методические указания к выполнению контрольной работы 
2.1 Правила работы с fuzzy-блоками в MATLAB 

1. Для вызова Fuzzy Logic Toolbox набрать в командной строке главного окна 
MATLAB слово fuzzy и нажать Enter. 

2. Откроется окно FIS Editor’а, которое позволит создать собственный фаззи-блок. 
Добавление входов и выходов осуществляется Edit→Add Variable→Input(Output). 
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3. Двойной щелчок на блоках input1 или output1 позволяет открыть окно Membership 

Function Editor для редактирования входных и выходных функций принадлежности. 

 
4. Для добавления новой функции принадлежности к существующим следует в 

главном меню окна Membership Function Editor выбрать Edit→Add MFs… или 
Edit→Add Custom MF… Удаление производится выбором нужной функции в графическом поле и 
нажатием клавиши Del. 

5. Двойной щелчок на блоке Untitled (Mamdani) позволяет открыть окно Rule Editor для 
редактирования фаззи-правил, т.е. установки логических взаимосвязей между входными и 
выходными функциями принадлежности. 
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6. Выбрав в меню Rule Editor пункт View→Rules можно увидеть 2D-отображение 

заданных fuzzy-правил. Здесь же можно, передвигая маркер по функциям входа, отобразить 
соответствующие им значения функций выхода. 

 
7. Выбрав в меню Rule Editor пункт View→Surface можно увидеть 3D-отображение 

заданных fuzzy-правил. Здесь же можно выбрать два входа для формирования координат точек по 
осям OX и OY и один из выходов для формирования координаты OZ. Изображение можно 
вращать вокруг любой из осей, передвигая мышь с нажатой левой клавишей на поверхности. 
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8. Для интегрирования разработанного fuzzy-блока в Simulink-модель, которая должна 

содержать fuzzy-регулятор, нужно убедиться, что fuzzy-блок сохранен в рабочем пространстве 
MATLAB под именем, которое используется при параметризации Simulink-блока Fuzzy Logic 
Controller. Для сохранения fuzzy-блока в рабочем пространстве MATLAB, нужно выбрать в меню 
окна FIS Editor’а Export→To Workspace… или Export→To Disk… В результате будет сформирован 
файл с расширением *.fis. 

9. Для загрузки fuzzy-регулятора из файла в рабочее пространство MATLAB Simulink в 
командной строке следует набрать команду fuz=readfis(‘Path’), где Path – строковая переменная, 
содержащая путь на диске к fis-файлу, например, D:\Мои документы\123.fis; fuz – имя внутренней 
FIS-матрицы, которая отвечает за отображение fuzzy-блока в Simulink. Признаком правильной 
загрузки будет отображение параметров файла: 
fuz =  
       name: 'fuzzyblock' 
       type: 'mamdani' 
       andMethod: 'min' 
       orMethod: 'max' 
        defuzzMethod: 'centroid' 
       impMethod: 'min' 
       aggMethod: 'max' 
       input: [1x2 struct] 
       output: [1x1 struct] 
       rule: [1x2 struct] 

10. После этого следует открыть Simulink-библиотеку Fuzzy Logic Toolbox и выбрать 
один из следующих блоков: Fuzzy Logic Controller или Fuzzy Logic Controller with Ruleviewer. 
Последний отличается возможностью в процессе моделирования наблюдать за изменением 
входных и выходных величин fuzzy-блока с помощью просмотрщика правил. 
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11. Выбранный Fuzzy Logic Controller необходимо идентифицировать путем указания 

имени FIS-матрицы, которая представляет его в среде MATLAB. 
 

2.2 Содержание работы 
 

 
 
Разработать нечеткий регулятор в соответствии с заданной таблицей фаззификации 

(табл. 1) 
 –10 –7,5 –5 –2,5 0 2,5 5 7,5 10 
( )eA1  0 0 0 0 0 0 0,3 0,7 1 
( )eA2  0 0 0 0 0,3 0,7 1 0,7 0,3 
( )eA3  0 0 0,3 0,7 1 0,7 0,3 0 0 
( )eA4  0,3 0,7 1 0,7 0,3 0 0 0 0 
( )eA5  1 0,7 0,3 0 0 0 0 0 0 

1A  – «большой положительный» 

2A  – «средний положительный» 

3A  – «нулевой» 

4A  – «средний отрицательный» 

5A  – «большой отрицательный» 
Fuzzy-правила, описывающие функциональность регулятора: 
• Если 3Ae =  и 3Ae =Δ , то 0x = ; 
• Если 2Ae =  и 2Ae =Δ , то 5x −= ; 
• Если 4Ae =  и 4Ae =Δ , то 5x = ; 
• Если 1Ae =  и 1Ae =Δ , то 10x −= ; 
• Если 5Ae =  и 5Ae =Δ , то 10x = . 

 
 
 

–10 0 
–5 0,25 
0 0,5 
5 0,75 
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